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To assess the performance of the LC-MS systems, four system suitability tests are available.

• First, the PepCalMix Infusion Test is performed to check the MS performance and to optimize the source
positioning and parameters.

• Next, the PepCalMix LC-MS System Suitability Test is performed to make sure that the system is in
basic working order and is providing good LC separation and MS sensitivity. This method is also used for
instrument mass calibration.

• Next, the Cell Lysate SWATH
®
 Acquisition QC Test test is performed to assess the performance of the

SWATH
®
 Acquisition and includes a digested human cell lysate with PepCalMix added.

• Finally, the Cell Lysate IDA QC Test is performed to assess the protein identification performance.

UseComponentsKit

PepCalMix Infusion Test

PepCalMix LC-MS System Suitability Test

PepCalMixMS Synthetic Peptide Calibration Kit
(part number 5045759)

Cell Lysate SWATH QC Test

Cell Lysate IDA QC Test

PepCalMix

K562 Protein Extract Digest

SWATH
®
 Acquisition Performance Kit

(part number 5045757)

All of the instrument methods for the NanoLCTM 425 and 415 systems, operating in a trap elute configuration, are
described. Use the following buffers for the LC system:

• Buffer A: 100% water with 0.1% formic acid

• Buffer B: 100% acetonitrile with 0.1% formic acid

For the nanoflow operation, the system is set up with a 75 µm i.d. nano column, with the temperature maintained
at 35°C. For the microflow operation, the system is set up with a 300 µm i.d. column, with the temperature
maintained at 35°C. The column oven can be mounted on the NanoLCTM system or on the DuoSprayTM ion source
tower.

Refer to Parts List for the NanoLC™ 425 System for the Nanoflow Test on page 51 for a list of parts that are
required for the nanoflow operation. Refer to Parts List to Upgrade the NanoLC™ 400 System for the Microflow
Test on page 55 for a list of parts that are required for the microflow operation.

Refer to Reference Documents on page 64 for a list of reference documents containing information about setting
up the sources or the LC-MS system.

Performance benchmarks for both the nanoflow and the microflow operations are available at
http://sciex.com/community/entity/15722.
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Test 1: PepCalMix Infusion Test – Source Tuning at
Nanoflow Rates

1. Make sure that the NanoSpray
®
 ion source is installed.

2. Prepare 50 fmol/µL of the PepCalMix solution.

Refer to Prepare the PepCalMix Infusion Solution on page 46.

Note: For the infusion protocol, use a 100 µL syringe and tubing with a 50 µm inside diameter (i.d.) to
100 µm i.d. For information about setting up the syringe line, refer to Create a Syringe Line on page 63.

Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must include the mass spectrometer and the syringe pump.

2. Set the acquisition parameters using the information in Table 2-1.

Note: In Manual Tune, multiple acquisitions in both MS and MS/MS will be performed.

Table 2-1 MS Method Information

400 to 1,500Mass RangeTOF MS

1 secAccumulation time

OptimizedSource Conditions
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Table 2-1 MS Method Information (continued)

100 to 1,500Mass RangeTOF MS/MS

1 secAccumulation time

964.98 / 758.91 / 533.3Product Ion1

High Sensitivity and High ResolutionMS/MS Type

45 / 40 / 25Collision Energy1

5Collision Energy Spread
1 MS/MS acquisition is performed on three different peptides in both resolution modes, resulting in the
acquisition of six MS/MS. The product ion masses shown in the table correspond to the collision energies
shown in the table.

Infusion

1. Connect the syringe to the source using the infusion line.

2. Infuse the PepCalMix solution at 0.5 µL/min for nanoflow testing.

3. Monitor the signal of the 758.91 m/z peptide with a TOF MS scan, as specified in Table 2-1.

4. Optimize the position of the sprayer and the source parameters for maximum stability and signal.

5. After optimization is completed, acquire the TOF MS data for 1 min. to confirm stable signal.

6. Acquire the MS/MS spectra on the three peptides as specified in Table 2-1, using both high sensitivity and high
resolution modes, for 1 min.

7. Open the data in the PeakView
®
 software to assess the data quality.

8. Select 30 sec. of the infusion TIC and then double-click to extract the spectrum.

9. From the PeakView
®
 software menu bar, click Window > Graph Selection Window.
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Figure 2-1 Graph Selection Info Dialog

10. Select the spectral peak of interest (the C12 peak for each) and then observe the Sum Intensity value for
each peak from the Graph Selection Window.

Tip! Zoom into the spectrum and then carefully select only the C12 peak of the isotope cluster.

Note: Intensities vary depending on the instrument and the flow rate. Performance specifications for QC
infusion are available at http://sciex.com/community/entity/15722.
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Figure 2-2 Example Data for TOF-MS Spectrum from Nanoflow Infusion

11. Track the peak intensities and resolution in MS and MS/MS over time to monitor the spray and MS performance.

Figure 2-3 Example Data for TOF-MS/MS Spectrum for Peptide m/z 758 from Nanoflow
Infusion
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Test 2: PepCalMix LC-MS System Suitability Test at
Nanoflow Rates
Make sure that the LC system and the MS are set up in trap elute mode and are equilibrated before performing
this test.

This LC-MS system QC test involves a TOF MS and looped MS/MS scan to test both MS and MS/MS sensitivity.
The shape and separation of the MS peaks will be used to assess the LC performance. This method also functions
as the instrument mass calibration method and should be performed at regular intervals during daily operation.

Prepare a solution of PepCalMix (10 fmol/µL), so that the 2 µL injection gives 20 fmol of PepCalMix on the column.
Refer to Prepare the PepCalMix LC-MS Solution for the Nanoflow Test on page 48.

Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must contain the correct LC-MS setup.

2. Create an MS acquisition method using the parameters in Table 2-2.

Table 2-2 MS Method Information

400 to1,250Mass RangeTOF MS

250 msecAccumulation time

OptimizedSource conditions

40 minDuration

100 to 1,500Mass RangeTOF MS/MS

500 msecAccumulation time

758.91Product Ion

High SensitivityMS/MS Type

40Collision Energy

5Collision Energy Spread
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Create an Autosampler Method

1. Plumb the autosampler using a 10 µL sample loop.

2. Create a µL pick-up autosampler method for an injection volume of 2 µL.

Refer to Reference Documents on page 64 for a list of reference documents containing information about
setting up autosampler methods.

3. Save the autosampler method.

4. Add the autosampler method to the MS method created in Create an MS Method on page 10.

Create a Pump Method for Nanoflow Rates

1. Create a loading pump method using a flow rate of 2 µL/min flow rate for 10 min., as shown in Figure 2-4.

Figure 2-4 Loading Pump Method

2. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

3. Save the loading pump method.

4. Add the loading pump method to the MS method created in Create an MS Method on page 10.

5. Create an analytical pump method using a flow rate of 300 nL/min flow rate, as shown in Figure 2-5.

Note: The method must be created using the correct pump channel, depending on whether the configuration
is a 415 or a 425 system.
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Figure 2-5 Analytical Pump Method

6. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

7. Save the analytical pump method.

8. Add the analytical pump method to the MS method created in Create an MS Method on page 10.

9. Save the LC-MS method.

10. Set the column temperature to 35°C.

System QC Procedure

1. Set up the LC and TripleTOF
®
 system as described previously in this section.

2. Acquire multiple injections of the PepCalMix until both the system pressure and the signal intensity stabilize.

Tip! If the column or trap are new, then multiple injections might be required to condition the column.
Consider injecting a complex mixture, such as the protein extract digest, to accelerate conditioning of new
columns or traps.

3. After the system is stabilized, inject the PepCalMix three times.

4. Open the data files in the PeakView
®
 software and extract the PepCalMix peptide ions from the TOF MS data

using the Extract Ions using Dialogue function.

Refer to the XIC table in PeakView® Software XIC Table for the PepCalMix Test on page 57.

5. Make sure that the peak shape and widths are acceptable, with an average peak width of 0.12 min. at half
height.

Note: Figure 2-6 shows a typical chromatogram for the PepCalMix at nanoflow. The peak areas vary
depending on the instrument and flow rate.

ProtocolSWATH® Acquisition Performance Kit
RUO-IDV-05-3363-A | 504575812 of 65

Tests for the Nanoflow Regime



Figure 2-6 Chromatogram for the PepCalMix with Nanoflow LC

6. Make sure that:

• The peak areas for the peptides are consistent across the three replicates.

• The retention times look reasonable and there is good separation of the peaks.

• The peak shapes are reasonably Gaussian, with minimal peak tailing.

• There are no large dead volumes that cause the peaks to elute very late.

7. From the TOF MS/MS data, extract an XIC of the 1070.5972 fragment ion.

8. Make sure that the MS/MS peak area can be reproduced across the three injections.
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Figure 2-7 Example Data of the MS/MS Spectrum of the 758.9105 m/z Peptide (Left) and
the XIC of 1070.5972 Fragment Ion (Right)

9. Make sure that the mass accuracy observed on average for the TOF MS and MS/MS peaks at peak apex is
better than 5 ppm.

Tip! When checking the mass accuracy, make sure that the instrument has been calibrated recently.

Note:  This PepCalMix method can be used for the LC-MS system QC throughout this document.

10. Track the results over time to make sure that the performance of the instrument is consistent.

11. From the PeakView
®
 software menu bar, click Window > Graph Selection Window.
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Figure 2-8 Graph Selection Info Dialog

12. Select the XIC peak of interest and then observe the Peak Area value for each peak from the Graph Selection
Window.

Note: Performance specifications are available at http://sciex.com/community/entity/15722.

Mass Calibration Procedure

Note:  We recommend that this method be used for instrument calibration throughout any proteomics study.

1. Before starting this test, make sure that the instrument is within 100 ppm in MS and MS/MS mode.

2. Click Tools > Settings > Tuning Options > Reference > New to create an instrument calibration
reference table.

3. Copy and paste the values from Table 2-3 and Table 2-4 into the instrument calibration reference table.

4. Edit the retention times to match the retention times determined from the replicate QC injections in System
QC Procedure on page 12.
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Table 2-3 Reference Ions for TOF MS Calibration

Retention
Time (min)

DP for
MS/MS

CE for
MS/MS

Use for
MS/MS

Precursor
m/z (Da)

Compound NameUse

15.680400408.55010AETSELHTSLK1

16.580400473.26020GAYVEVTAK1

12.780400485.25302IGNEQGVSR1

1580400491.26559LVGTPAEER1

1880400519.79969LDSTSIPVAK1

20.380400533.32333AGLIVAEGVTK1

24.280400540.27342LGLDFDSFR1

22.580400549.28633GFTAYYIPR1

24.480400569.83398SGGLLWQLVR1

17.180400583.31360AVGANPEQLTR1

18.280400593.80053SAEGLDASASLR1

23.680400613.34955VFTPLEVDVAK1

21.680400636.35273VGNEIQYVALR1

20.480400657.34499YIELAPGVDNSK1

21.780400677.85827DGTFAVDGPGVIAK1

18.880400739.36148YDSINNTEVSGIR1

22.180401758.91050SPYVITGPGVVEYK1

20.480400768.90340ALENDIGVPSDATVK1

24.280400883.47380AVYFYAPQIPLYANK1

23.380400964. 97741TVESLFPEEAETPGSAVR1

Table 2-4 Reference Ions for MS/MS Calibration

Fragment m/z (Da)Fragment NameUse

185.09207b21

348.15540b31

560.30788b41
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Table 2-4 Reference Ions for MS/MS Calibration (continued)

Fragment m/z (Da)Fragment NameUse

661.35555b51

758.91050N/A1

799.44398y71

856.46544y81

957.51312y91

1070.59719y101

1169.66560y111

1332.72893y121

5. Create another batch with the calibration activated and provide the new PepCalMix Calibrant Reference Table
and the PepCalMix method information. Refer to Figure 2-9.

Figure 2-9 Activated Calibration

6. Submit the new batch and then confirm that the calibration passes.

Note: When the mass calibration is successful, a green check mark is shown for the Calibration run in the
Queue Manager.
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Test 3: Cell Lysate SWATH
®
 Acquisition QC Test at

Nanoflow Rates
After performing the PepCalMix LC-MS System Suitability Test, the SWATH

®
 Acquisition QC test can be performed.

1. Prepare the stock solution of the Protein Extract Digest (2 ug/uL) as described in Prepare the Protein Extract
Digest Stock Solution on page 47.

2. Prepare a solution of Protein Extract Digest (0.5 µg/µL) and PepCalMix (50 fmol/µL) as described in Prepare
the SWATH® Acquisition QC Solution for the Nanoflow Test on page 49, so that the 2 µL injection results in
a 1 µg total protein and 100 fmol of PepCalMix on the column.

Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must contain the correct LC-MS setup.

2. Create an MS acquisition method using the parameters in Table 2-5.

Note: For information about creating SWATH
®
 data, refer to the https://training.sciex.com/Course.aspx?c=336

eLearning module.

Table 2-5 MS Method Information

400 to 1,250Mass RangeTOF MS

250 msecAccumulation speed

OptimizedSource conditions

100 minDuration
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Table 2-5 MS Method Information (continued)

100 to 1,500Mass RangeTOF MS/MS

25 msecAccumulation speed

100 Variable window1SWATH window text file

High SensitivityMS/MS Type

Rolling CE2, 2+ selectedCollision Energy

3.2 secCycle time

1 This file can be download from http://sciex.com/community/entity/1217.
2 Optimized rolling CE curves can be downloaded from http://sciex.com/community/entity/11856.

Create an Autosampler Method

1. Plumb the autosampler using a 10 µL sample loop.

2. Create a µL pick-up autosampler method for an injection volume of 2 µL.

3. Save the autosampler method.

4. Add the autosampler method to the MS method created in Create an MS Method on page 18.

Refer to Reference Documents on page 64 for a list of reference documents containing information about
setting up autosampler methods.

Create a Pump Method for Nanoflow Rates

1. Create a loading pump method using a flow rate of 2 µL/min flow rate for 10 min., as shown in Figure 2-10.

Figure 2-10 Loading Pump Method
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2. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

3. Save the loading pump method.

4. Add the loading pump method to the MS method created in Create an MS Method on page 18.

5. Create an analytical pump method using a flow rate of 300 nL/min flow rate, as shown in Figure 2-11.

Note: The method must be created using the correct pump channel, depending on whether the configuration
is a 415 or a 425 system.

Figure 2-11 Analytical Pump Method

6. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

7. Save the analytical pump method.

8. Add the analytical pump method to the MS method created in Create an MS Method on page 18.

9. Save the LC-MS method.

10. Set the column temperature to 35°C.

SWATH
®
 Acquisition QC Procedure

1. Set up the LC and TripleTOF
®
 system as described previously in this section.

2. Acquire multiple injections of the SWATH
®
 Acquisition QC Solution until the system pressure and signal intensity

stabilize.

Tip! If the column or trap are new, then multiple injections might be required to condition the column.
Consider injecting a complex mixture, such as the protein extract digest, to accelerate conditioning of new
columns or traps.
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3. After the system is stabilized, run the SWATH
®
 Acquisition QC test on the SWATH

®
 Acquisition QC Solution

five times.

4. Make sure that good chromatographic and TIC intensity reproducibility is achieved.

Note: A representative TIC is shown in Figure 2-12. Intensities vary depending on the instrument and flow
rate. Performance specifications are available at http://sciex.com/community/entity/15722.

Figure 2-12 Total Ion Chromatogram (TIC) of Replicate SWATH Injections

5. Process the data with the SWATH
®
 2.0 MicroApp in the PeakView

®
 software, using the Human Ion Library file

(Human2D_PepCalMix SOP Library.txt). Refer to SWATH® Acquisition Processing Using a Library on page 58
for processing information.

Tip! The library can be downloaded from http://sciex.com/community/entity/15722.

6. After the processing is complete, click Export > All to export all of the results and then analyze them using
the SWATH Replicates Template. Refer to SWATH® Replicates Analysis Template on page 61.

7. Make sure that the reproducibility curves on the Simple Summary tab look similar to those shown in Figure
2-13.

The most important statistic to review in this dashboard is the red curve in the graph. This curve shows that
approximately 70% of the transitions have a %CV better than 20%. This indicates good quantitative robustness
across the replicates.
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Figure 2-13 Reproducibility Curves

8. Obtain the performance numbers from the Simple Summary tab.

9. Track the results over time to make sure that the performance of the instrument is consistent.

Note: This is easily accomplished by copying the single column of results from the Results – Single
Column tab and storing them in a separate Excel sheet.

Test 4: Cell Lysate IDA QC Test at Nanoflow Rates
After performing the PepCalMix LC-MS System Suitability Test, the IDA QC test can be performed.

1. Prepare the stock solution of the Protein Extract Digest (2 ug/uL) as described in Prepare the Protein Extract
Digest Stock Solution on page 47.

2. Prepare a solution of Protein Extract Digest (0.5 µg/µL) as described in Prepare the IDA QC Solution for the
Nanoflow Test on page 50, so that the 2 µL injection results in a 1 µg total protein on the column.
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Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must contain the correct LC-MS setup.

2. Create an MS acquisition method using the parameters in Table 2-6.

Note: In Manual Tune, multiple acquisitions in both MS and MS/MS will be performed.

Table 2-6 MS Method Information

400 to 1,250Mass RangeTOF MS

250 msecAccumulation speed

OptimizedSource conditions

130 minDuration

100 to– 1,500Mass RangeTOF MS/MS

50 msecAccumulation speed

High SensitivityMS/MS Type

400For ions greater thanSwitch Criteria

1,250For ions smaller than

2 to 5With charge state

150 cpsWhich exceeds

100 ppmMass Tolerance

30Max # of candidates

15 secExclude for

0nRolling collision energy1IDA Advanced

1 Optimized rolling CE curves can be downloaded from http://sciex.com/community/entity/11856.
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Create an Autosampler Method

1. Plumb the autosampler using a 10 µL sample loop.

2. Create a µL pick-up autosampler method for an injection volume of 2 µL.

3. Save the autosampler method.

4. Add the autosampler method to the MS method created in Create an MS Method on page 23.

Refer to Reference Documents on page 64 for a list of reference documents containing information about
setting up autosampler methods.

Create a Pump Method for Nanoflow Rates

1. Use the same loading pump method as used for the SWATH
®
 Acquisition QC Test.

2. Add the loading pump method to the MS method created in Create an MS Method on page 23.

3. Create an analytical pump method using a flow rate of 300 nL/min flow rate, as shown in Figure 2-14.

Note: The method must be created using the correct pump channel, depending on whether the configuration
is a 415 system or a 425 system.

Figure 2-14 Analytical Pump Method

4. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

5. Save the analytical pump method.

6. Add the analytical pump method to the MS method created in Create an MS Method on page 23.
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7. Save the LC-MS method.

8. Set the column temperature to 35°C.

IDA QC Procedure

1. Set up the LC and TripleTOF
®
 system as described previously in this section.

2. Acquire multiple injections of the IDA QC Solution until the system pressure and signal intensity stabilize.

Tip!  If the column or trap are new, then multiple injections might be required to condition the column.
Consider injecting a complex mixture, such as the protein extract digest, to accelerate conditioning of new
columns or traps.

3. After the system is stabilized, run the IDA QC test on the IDA QC Solution three times.

4. Process the data using the ProteinPilotTM software, version 5.0.

Figure 2-15 Paragon Method

5. Open the FDR report that is produced with each search and then determine the average number of proteins
and peptides found at 1% FDR (Global).
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Test 1: PepCalMix Infusion Test – Source Tuning at
Microflow Rates

1. Make sure that the DuoSprayTM ion source is installed on the system.

2. Make sure that the 25 µm ID hybrid electrodes are installed in the source.

3. Prepare 50 fmol/µL of the PepCalMix solution.

Refer to Prepare the PepCalMix Infusion Solution on page 46.

Note: For the infusion protocol, use a 100 µL syringe and tubing with a 50 µm inside diameter (i.d.) to
100 µm i.d. For information about setting up the syringe line, refer to Create a Syringe Line on page 63.

Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must include the mass spectrometer and the syringe pump.

2. Set the acquisition parameters using the information in Table 3-1.

Note: In Manual Tune, multiple acquisitions in both MS and MS/MS will be performed.

Table 3-1 MS Method Information

400 to 1,500Mass RangeTOF MS

1 secAccumulation time

OptimizedSource Conditions
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Table 3-1 MS Method Information (continued)

100 to 1,500Mass RangeTOF MS/MS

1 secAccumulation time

964.98 / 758.91 / 533.3Product Ion1

High Sensitivity and High ResolutionMS/MS Type

45 / 40 / 25Collision Energy1

5Collision Energy Spread
1 MS/MS acquisition is performed on three different peptides in both resolution modes, resulting in the
acquisition of six MS/MS. The product ion masses shown in the table correspond to the collision energies
shown in the table.

Infusion

1. Connect the syringe to the source using the infusion line.

2. Infuse the PepCalMix solution at 5 µL/min for microflow testing.

3. Monitor the signal of the 758.91 m/z peptide with a TOF MS scan, as specified in Table 3-1.

4. Optimize the position of the sprayer and the source parameters for maximum stability and signal.

5. After optimization is completed, acquire the TOF MS data for 1 min. to confirm stable signal.

6. Acquire the MS/MS spectra on the three peptides as specified in Table 3-1, using both high sensitivity and high
resolution modes, for 1 min.

7. Open the data in the PeakView
®
 software to assess the data quality.

8. Select 30 sec. of the infusion TIC and then double-click to extract the spectrum.

9. From the PeakView
®
 software menu bar, click Window > Graph Selection Window.
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Figure 3-1 Graph Selection Info Dialog

10. Select the spectral peak of interest (the C12 peak for each) and then observe the Sum Intensity value for
each peak from the Graph Selection Window.

Tip! Zoom into the spectrum and then carefully select only the C12 peak of the isotope cluster.

Note: Intensities vary depending on the instrument and the flow rate. Performance specifications for QC
infusion are available at http://sciex.com/community/entity/15722.

11. Track the peak intensities and resolution in MS and MS/MS over time to monitor the spray and MS performance.

Test 2: PepCalMix LC-MS System Suitability Test at
Microflow Rates
Make sure that the LC system and the MS are set up in trap elute mode and are equilibrated before performing
this test.

This LC-MS system QC test involves a TOF MS and looped MS/MS scan to test both MS and MS/MS sensitivity.
The shape and separation of the MS peaks will be used to assess the LC performance. This method also functions
as the instrument mass calibration method and should be performed at regular intervals during daily operation.

Prepare a solution of PepCalMix (20 fmol/µL) so that the 2 µL injection gives 40 fmol of PepCalMix on the column.
Refer to Prepare the PepCalMix LC-MS Solution for the Microflow Test on page 52.
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Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must contain the correct LC-MS setup.

2. Create an MS acquisition using the parameters in Table 3-2.

Note: In Manual Tune, multiple acquisitions in both MS and MS/MS will be performed.

Table 3-2 MS Method Information

400 to 1,250Mass RangeTOF MS

250 msecAccumulation time

OptimizedSource conditions

12 minDuration

100 to 1,500Mass RangeTOF MS/MS

500 msecAccumulation time

758.91Product Ion

High SensitivityMS/MS Type

40Collision Energy

5Collision Energy Spread

Create an Autosampler Method

1. Plumb the autosampler using a 10 µL sample loop.

2. Create a µL pick-up autosampler method for an injection volume of 2 µL.

Refer to Reference Documents on page 64 for a list of reference documents containing information about
setting up autosampler methods.

3. Save the autosampler method.

4. Add the autosampler method to the MS method created in Create an MS Method on page 29.
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Create a Pump Method for Microflow Rates

1. Create a loading pump method using a flow rate of 10 µL/min flow rate for 3 min., as shown in Figure 3-2.

Figure 3-2 Loading Pump Method

2. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

3. Save the loading pump method.

4. Add the loading pump method to the MS method created in Create an MS Method on page 29.

5. Create an analytical pump method using a flow rate of 5 µL/min flow rate, as shown Figure 3-3.

Note: The method must be created using the correct pump channel, depending on whether the configuration
is a 415 or a 425 system.

Figure 3-3 Analytical Pump Method

6. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

7. Save the analytical pump method.

8. Add the analytical pump method to the MS method created in Create an MS Method on page 29.
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9. Save the LC-MS method.

10. Set the column temperature to 35°C.

System QC Procedure

1. Set up the LC and TripleTOF
®
 system as described previously in this section.

2. Acquire multiple injections of the PepCalMix until the system pressure and signal intensity stabilize.

Tip! If the column or trap are new, then multiple injections might be required to condition the column.
Consider injecting a complex mixture, such as the protein extract digest, to accelerate conditioning of new
columns or traps.

3. After the system is stabilized, inject the PepCalMix three times.

4. Open the data files in the PeakView
®
 software and extract the PepCalMix peptide ions from the TOF MS data

using the Extract Ions using Dialogue function.

Refer to the XIC table in PeakView® Software XIC Table for the PepCalMix Test on page 57.

5. Make sure that the peak shape and widths are acceptable, with an average peak width of 0.05 min. at half
height.

Note: Figure 2-6 shows a typical chromatogram for the PepCalMix at microflow. The peak areas vary
depending on the instrument and flow rate.
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Figure 3-4 Chromatogram for the PepCalMix

6. Make sure that:

• The peak areas for the peptides are consistent across the three replicates.

• The retention times look reasonable and there is good separation of the peaks.

• The peak shapes are reasonably Gaussian, with minimal peak tailing.

• There are no large dead volumes that cause the peaks to elute very late.

7. From the TOF MS/MS data, extract an XIC of the 1070.5972 fragment ion.

8. Make sure that the MS/MS peak area can be reproduced across the three injections.
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Figure 3-5 Example Data of the MS/MS Spectrum of the 758.9105 m/z Peptide (Left) and
the XIC of 1070.5972 Fragment Ion (Right)

9. Make sure that the mass accuracy observed on average for the TOF MS and MS/MS peaks at peak apex is
better than 5 ppm.

Tip! When checking the mass accuracy, make sure that the instrument has been calibrated recently.

Note:  This PepCalMix method is used for the LC-MS system QC throughout the course of your studies.

10. Track the results over time to make sure that the performance of the instrument is consistent.

11. From the PeakView
®
 software menu bar, click Window > Graph Selection Window.
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Figure 3-6 Graph Selection Info Dialog

12. Select the XIC peak of interest and then observe the Peak Area value for each peak from the Graph Selection
Window.

Note: Performance specifications are available at http://sciex.com/community/entity/15722.

Mass Calibration Procedure

Note:  We recommend that this method be used for instrument calibration throughout any proteomics study.

1. Before starting this test, make sure that the instrument is within 100 ppm in MS and MS/MS mode.

2. Click Tools > Settings > Tuning Options > Reference > New to create an instrument calibration
reference table.

3. Copy and paste the values from Table 2-3 and Table 2-4 into the instrument calibration reference table.

4. Edit the retention times to match the retention times determined from the replicate QC injections in System
QC Procedure on page 31.
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Table 3-3 Reference Ions for TOF MS Calibration

Retention
Time (min)

DP for
MS/MS

CE for
MS/MS

Use for
MS/MS

Precursor
m/z (Da)

Compound NameUse

4.280400408.55010AETSELHTSLK1

4.4780400473.26020GAYVEVTAK1

3.2680400485.25302IGNEQGVSR1

4.1580400491.26559LVGTPAEER1

4.880400519.79969LDSTSIPVAK1

5.480400533.32333AGLIVAEGVTK1

6.6180400540.27342LGLDFDSFR1

5.8480400549.28633GFTAYYIPR1

6.9780400569.83398SGGLLWQLVR1

4.5580400583.31360AVGANPEQLTR1

4.8480400593.80053SAEGLDASASLR1

6.1480400613.34955VFTPLEVDVAK1

5.6280400636.35273VGNEIQYVALR1

5.3880400657.34499YIELAPGVDNSK1

6.6380400677.85827DGTFAVDGPGVIAK1

4.9180400739.36148YDSINNTEVSGIR1

5.7180401758.91050SPYVITGPGVVEYK1

5.2780400768.90340ALENDIGVPSDATVK1

6.5880400883.47380AVYFYAPQIPLYANK1

680400964. 97741TVESLFPEEAETPGSAVR1

Table 3-4 Reference Ions for MS/MS Calibration

Fragment m/z (Da)Fragment NameUse

185.09207b21

348.15540b31

560.30788b41
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Table 3-4 Reference Ions for MS/MS Calibration (continued)

Fragment m/z (Da)Fragment NameUse

661.35555b51

758.91050N/A1

799.44398y71

856.46544y81

957.51312y91

1070.59719y101

1169.66560y111

1332.72893y121

5. Create another batch with the calibration activated and then provide the new PepCalMix Calibrant Reference
Table and the PepCalMix method information.

Figure 3-7 Activated Calibration

6. Submit the new batch and confirm that the calibration passes.

Note: When the mass calibration is successful, a green check mark is shown for the Calibration run in the
Queue Manager.
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Test 3: Cell Lysate SWATH
®
 Acquisition QC Test at

Microflow Rates
After performing the PepCalMix LC-MS System Suitability Test, the SWATH

®
 Acquisition QC test can be performed.

1. Prepare the stock solution of the Protein Extract Digest (2 ug/uL) as described in Prepare the Protein Extract
Digest Stock Solution on page 47.

2. Prepare a solution of Protein Extract Digest (1 µg/µL) and PepCalMix (100 fmol/µL) as described in Prepare the
SWATH® Acquisition QC Solution for the Microflow Test on page 53, so that the 4 µL injection results in a 4
µg total protein and 400 fmol of PepCalMix on the column.

Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must contain the correct LC-MS setup.

2. Create an MS acquisition method using the parameters in Table 2-5.

Note: For information about creating SWATH
®
 data, refer to the https://training.sciex.com/Course.aspx?c=336

eLearning module.

Table 3-5 MS Method Information

400 to 1,250Mass RangeTOF MS

250 msecAccumulation speed

OptimizedSource conditions

55 minDuration
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Table 3-5 MS Method Information (continued)

100 to 1,500Mass RangeTOF MS/MS

25 msecAccumulation speed

100 Variable window1SWATH window text file

High SensitivityMS/MS Type

Rolling CE2, 2+ selectedCollision Energy

3.2 secCycle time

1 This file can be download from http://sciex.com/community/entity/1217.
2 Optimized rolling CE curves can be downloaded from http://sciex.com/community/entity/11856.

Create an Autosampler Method

1. Plumb the autosampler using a 10 µL sample loop.

2. Create a µL pick-up autosampler method for an injection volume of 4 µL.

3. Save the autosampler method.

4. Add the autosampler method to the MS method created in Create an MS Method on page 37.

Refer to Reference Documents on page 64 for a list of reference documents containing information about
setting up autosampler methods.

Create a Pump Method for Microflow Rates

1. Create a loading pump method using a flow rate of 10 µL/min flow rate for 3 min., as shown in Figure 3-8.

Figure 3-8 Loading Pump Method

2. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.
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3. Save the loading pump method.

4. Add the loading pump method to the MS method created in Create an MS Method on page 37.

5. Create an analytical pump method using a flow rate of 5 µL/min flow rate, as shown in Figure 3-9.

Note: The method must be created using the correct pump channel, depending on whether the configuration
is a 415 or a 425 system.

Figure 3-9 Analytical Pump Method

6. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

7. Save the analytical pump method.

8. Add the analytical pump method to the MS method created in Create an MS Method on page 37.

9. Save the LC-MS method.

10. Set the column temperature to 35°C.

SWATH
®
 Acquisition QC Procedure

1. Set up the LC and TripleTOF
®
 system as described previously in this section.

2. Acquire multiple injections of the SWATH
®
 Acquisition QC Solution until the system pressure and signal intensity

stabilize.

Tip! If the column or trap are new, then multiple injections might be required to condition the column.
Consider injecting a complex mixture, such as the protein extract digest, to accelerate conditioning of new
columns or traps.
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3. After the system is stabilized, run the SWATH
®
 Acquisition QC test on the SWATH

®
 Acquisition QC Solution

five times.

4. Make sure that good chromatographic and TIC intensity reproducibility is achieved.

Note: A representative TIC is shown in Figure 3-10. Intensities vary depending on the instrument and flow
rate. Performance specifications are available at http://sciex.com/community/entity/15722.

Figure 3-10 Total Ion Chromatogram (TIC) of Replicate SWATH Injections

5. Process the data with the SWATH
®
 2.0 MicroApp in the PeakView

®
 software, using the Human Ion Library file

(Human2D_PepCalMix SOP Library.txt). Refer to SWATH® Acquisition Processing Using a Library on page 58
for processing information.

Tip! The library can be downloaded from http://sciex.com/community/entity/15722.

6. After the processing is complete, click Export > All to export all of the results and then analyze them using
the SWATH Replicates Template. Refer to SWATH® Replicates Analysis Template on page 61.

7. Make sure that the reproducibility curves on the Simple Summary tab look similar to those shown in Figure
3-11.

The most important statistic to review in this dashboard is the red curve in the graph. This curve shows that
approximately 70% of the transitions have a %CV better than 20%. This indicates good quantitative robustness
across the replicates.
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Figure 3-11 Reproducibility Curves

8. Obtain the performance numbers from the Simple Summary tab.

9. Track the results over time to make sure that the performance of the instrument is consistent.

Note: This is easily accomplished by copying the single column of results from the Results – Single
Column tab and storing them in a separate Excel sheet.

Test 4: Cell Lysate IDA QC Test at Microflow Rates
After performing the PepCalMix LC-MS System Suitability Test, the IDA QC test can be performed.

1. Prepare the stock solution of the Protein Extract Digest (2 ug/uL) as described in Prepare the Protein Extract
Digest Stock Solution on page 47.

2. Prepare a solution of Protein Extract Digest (1 µg/µL) as described in Prepare the IDA QC Solution for the
Microflow Test on page 54, so that the 4 µL injection results in a 4 µg total protein on the column.
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Create an MS Method

1. Make sure that the correct hardware profile is activated.

Note: The hardware profile must contain the correct LC-MS setup.

2. Create an MS acquisition method using the parameters in Table 3-6.

Note: In Manual Tune, multiple acquisitions in both MS and MS/MS will be performed.

Table 3-6 MS Method Information

400 to 1,250Mass RangeTOF MS

250 msecAccumulation speed

OptimizedSource conditions

85 minDuration

100 to 1,500Mass RangeTOF MS/MS

50 msecAccumulation speed

High SensitivityMS/MS Type

400For ions greater thanSwitch Criteria

1,250For ions smaller than

2 to 5With charge state

150 cpsWhich exceeds

100 ppmMass Tolerance

30Max # of candidates

15 secExclude for

0nRolling collision energy1IDA Advanced

1 Optimized rolling CE curves can be downloaded from http://sciex.com/community/entity/11856.
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Create an Autosampler Method

1. Plumb the autosampler using a 10 µL sample loop.

2. Create a µL pick-up autosampler method for an injection volume of 4 µL.

3. Save the autosampler method.

4. Add the autosampler method to the MS method created in Create an MS Method on page 42.

Refer to Reference Documents on page 64 for a list of reference documents containing information about
setting up autosampler methods.

Create a Pump Method for Microflow Rates

1. Use the same loading pump method as used for the SWATH
®
 Acquisition QC Test.

2. Add the loading pump method to the MS method created in Create an MS Method on page 42.

3. Create an analytical pump method using a flow rate of 5 µL/min flow rate, as shown in Figure 3-12.

Note: The method must be created using the correct pump channel, depending on whether the configuration
is a 415 system or a 425 system.

Figure 3-12 Analytical Pump Method

4. Select the Run Conditions tab and then set the Sample Injection Mode to Standard.

5. Save the analytical pump method.

6. Add the analytical pump method to the MS method created in Create an MS Method on page 42.

7. Save the LC-MS method.

8. Set the column temperature to 35°C.
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IDA QC Procedure

1. Set up the LC and TripleTOF
®
 system as described previously in this section.

2. Acquire multiple injections of the IDA QC Solution until the system pressure and signal intensity stabilize.

Tip!  If the column or trap are new, then multiple injections might be required to condition the column.
Consider injecting a complex mixture, such as the protein extract digest, to accelerate conditioning of new
columns or traps.

3. After the system is stabilized, run the IDA QC test on the IDA QC Solution three times.

4. Process the data using the ProteinPilotTM software, version 5.0.

Figure 3-13 Paragon Method

5. Open the FDR report that is produced with each search and determine the average number of proteins and
peptides found at 1% FDR (Global).
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The following information must be noted and the relevant safety measures taken. Refer to the respective safety
data sheets for more information. These are available upon request or can be downloaded from our Web site
sciex.com.

Classification according to Regulation (EC) No 1272/2008 and OSHA
Hazard Communication Standard (29 CFR 1910.1200)

Hazard Symbol

PepCalMix (part number 5045751)

GHS02 flame

• Flam. Liq. 2 H225 Highly flammable liquid and vapor. (US and EU)

GHS05 corrosion

• Skin Corr. 1 H314 Causes severe skin burns and eye damage. (US and EU)

• Eye Dam. 1 H318 Causes serious eye damage. (US and EU)

GHS08 health hazard

• STOT 2 (Repeated exposure) Blood system and cardiovascular system. (US)

This component is not classified as hazardous according to EC 1272/2008 and 29 CFR 1910.1200:

• K562 Protein Extract Digest (part number 5045752)
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The PepCalMix vial contains 50 pmol of each of the 20 different stable isotope labeled peptides in 50 µL of solvent.
It is a stock solution of 1 pmol/μL for each peptide.

1. When opening a new vial of the stock solution, aliquot the stock solution (1 pmol/μL concentration) into 5 μL
to 10 μL volumes and then freeze for future use.

2. Add 5 μL of the PepCalMix stock solution and 95 µL of 10% Buffer B (10% acetonitrile : 5% acetic acid) to the
vial.

Note: Acetic acid is essential for the stability of the higher mass peptides and must not be substituted.

3. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

4. Using a centrifuge, spin the vial to bring the liquid to the bottom of the vial before opening.

Note:  A certificate of analysis (CoA) for the PepCalMix can be downloaded from the Web site
http://sciex.com/tech-regulatory.
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Use this procedure to prepare the Protein Extract Digest stock solution from the vial provided in the SWATH
®

Performance Kit. Because the vial contains 100 μg, this procedure produces a stock solution of 2 μg/μL.

1. Add 50 μL of Buffer A (100% water: 0.1% formic acid) to the vial.

2. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

3. Shake the vial to bring the liquid to the bottom of the vial before opening.

4. Repeat steps 2 and 3 to confirm dissolution.

5. Aliquot the stock solution (2 μg/μL concentration) into 5 μL to 10 μL volumes and then freeze for future use.
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Use this procedure to prepare the PepCalMix stock solution (1 pmol/μL) from the vial provided in the SWATH
®

Performance Kit.

1. When opening a new vial of the stock solution, aliquot the stock solution (1 pmol/μL concentration) into 5 μL
to 10 μL volumes and then freeze for future use.

2. Add 99 μL of the dilution buffer (5% acetic acid : 2% acetonitrile) to a vial, and then add 1 μL of the PepCalMix
stock solution to prepare a 10 fmol/μL solution.

Note: Acetic acid is essential for the stability of the higher mass peptides and must not be substituted.

3. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

4. Using a centrifuge, spin the vial to bring the liquid to the bottom of the vial before opening.

5. Pipette the solution into an autosampler vial.

Note:  A certificate of analysis (CoA) for the PepCalMix can be downloaded from the Web site
http://sciex.com/tech-regulatory.
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Use this procedure to prepare a dilution that contains 0.5 μg/μL of Protein Extract Digest and 50 fmol/μL of the
PepCalMix.

1. Add 14 μL of Buffer A (100% water: 0.1% formic acid) to the vial.

2. Add 5 μL of the Protein Extract Digest Stock solution to the vial. Refer to Prepare the Protein Extract Digest
Stock Solution on page 47 for information about preparing the stock solution.

3. Add 1 μL of the PepCalMix stock solution to the vial.

4. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

5. Using a centrifuge, spin the vial to bring the liquid to the bottom of the vial before opening.

6. Pipette the solution into an autosampler vial.
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Use this procedure to prepare a dilution that contains 0.5 μg/μL of Protein Extract Digest.

1. Add 15 μL of Buffer A (100% water: 0.1% formic acid) to the vial.

2. Add 5 μL of the Protein Extract Digest Stock solution to the vial.

3. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

4. Using a centrifuge, spin the vial to bring the liquid to the bottom of the vial before opening.

5. Pipette the solution into an autosampler vial.
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Table G-1 is a list of all of the parts required to perform the nanoflow test. All of the part numbers are SCIEX part
numbers, unless otherwise indicated.

Table G-1 Parts List

DescriptionItem# NeededPart Number

For use with NanoSpray
®
 ion

source
New Objectives nanoflow spray tips1FS 360-20-10-N-20

(New Objectives)

Vials for proteomic analysis11 mm PP 250 µl vial (100/pkg)1910-00104

Slit septum lids for vials11 mm snap cap with slit septum
(100/pkg)

1910-00103

Trap column good for
proteomics at 2 µL/min flow
rates. Use serial column
workflow for higher
performance, if required.

ChromXP nanoLC Trap column 350 μm
id x 0.5 mm, ChromXP C18 3 μm 120Å
(2/pkg)

15016752

Analytical column good for
proteomics at 300 nL/min flow
rates

ChromXP nanoLC column 75 μm id x 15
cm, ChromXP C18 3um 120Å1

1805-00120

To connect the analytical pump
to the autosampler trap valve.

Tubing, 20 μm i.d., 1/32 inch o.d., 75 cm
PEEKsil (natural)

1205-00048

To connect the load pump to the
autosampler injection valve.

Tubing, 50 μm i.d., 1/32 inch o.d., 75 cm
PEEKsil (natural)

3205-00049

To connect the autosampler
injection valve to the
autosampler trap valve.

Tubing, 50 μm i.d., 1/32 inch o.d., 30 cm
PEEKsil

1205-00040

Waste tubing for autosampler
trap valve.

Tubing, FEP, 1/32 OK 5-foot roll1200-00320

For PEEKsil tubing connections
on all valves.

1/32 inch PEEK nut with glass-filled PEEK
ferrule (10/ pkg)

15019621

1 If the exact column configuration is not available, then use an equivalent column length and diameter.
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Use this procedure to prepare the PepCalMix stock solution (1 pmol/μL) from the vial provided in the SWATH
®

Performance Kit.

1. When opening a new vial of the stock solution, aliquot the stock solution (1 pmol/μL concentration) into 5 μL
to 10 μL volumes and then freeze for future use.

2. Add 49 μL of the dilution buffer (5% acetic acid : 2% acetonitrile) to a vial, and then add 1 μL of the PepCalMix
stock solution to prepare a 20 fmol/μL solution.

Note: Acetic acid is essential for the stability of the higher mass peptides and must not be substituted.

3. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

4. Using a centrifuge, spin the vial to bring the liquid to the bottom of the vial before opening.

5. Pipette the solution into an autosampler vial.

Note:  A certificate of analysis (CoA) for the PepCalMix can be downloaded from the Web site
http://sciex.com/tech-regulatory.
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Use this procedure to prepare a dilution that contains 1 μg/μL of Protein Extract Digest and 100 fmol/μL of the
PepCalMix.

1. Add 9.6 μL of Buffer A (100% water: 0.1% formic acid) to the vial.

2. Add 12 μL of the Protein Extract Digest Stock solution to the vial.

3. Add 2.4 μL of the PepCalMix stock solution to the vial.

4. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

5. Using a centrifuge, spin the vial to bring the liquid to the bottom of the vial before opening.

6. Pipette the solution into an autosampler vial.

SWATH® Acquisition Performance KitProtocol
53 of 65RUO-IDV-05-3363-A | 5045758

I

Prepare the SWATH® Acquisition
QC Solution for the Microflow
Test



Use this procedure to prepare a dilution that contains 1 μg/μL of Protein Extract Digest.

1. Add 10 μL of Buffer A (100% water: 0.1% formic acid) to the vial.

2. Add 10 μL of the Protein Extract Digest Stock solution to the vial.

3. Using a vortex mixer, mix the solution for a minimum of 30 seconds.

4. Using a centrifuge, spin the vial to bring the liquid to the bottom of the vial before opening.

5. Pipette the solution into an autosampler vial.
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Table K-1 is a list of all of the parts required to adapt the nanoflow configuration to a microflow configuration.
The main parts are defined for optimal performance. However, options that could be substituted for added
robustness, if required, are also defined in italics.

Table K-1 Parts List

DescriptionItem#
Needed

Part
Number

For columns up to 25 cm. Ambient
temperature from 5°C to 60°C.

ekspert NanoLCTM 400 column oven15019593

To attach the column oven to the source
tower.

Source Clamp15028230

Rods and clamps to attach the column
oven to the NanoLC 425 system.

Column Mounting Kit15017449

To adapt for microflow rates.ekspert NanoLCTM 400 gradient flow
module for 1 µL/min to 10 µL/min

15018237

To adapt the DuoSprayTM or the Turbo VTM

ion source for microflow. Always have a
spare on hand in case of plugging.

25 Micron ESI Electrode15028467

Optional: Higher ID electrode for
robustness.

50 Micron ESI Electrode—5028466

Good for proteomics at 5 µL/min flow
rates.

Column, 3 μm, ChromXP, C18CL, 120A,
150 × 0.3 mm

15022436

For trap elute workflows.Trap Cartridge holder with 1/32 inch peek
fittings

15027467

For trap elute workflows.0.3 mm trap cartridges, ChromXP, C18CL,
5 μm 120A (5/pkg)

15028897

To connect the load pump to the
autosampler injection valve, the analytical
pump to the autosampler trap valve, and
the autosampler trap valve to the column
for 5 µL/min flow rates.

Tubing, 50 μm i.d., 1/32 inch o.d., 75 cm
PEEKsil (natural)

3205-00049
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Table K-1 Parts List (continued)

DescriptionItem#
Needed

Part
Number

Post column connection to source. Always
have a spare on hand in case of plugging.

Tubing, 25 μm i.d., 1/32 inch o.d., 10 cm
PEEKsil

1205-00091

Optional: Higher ID tubing for
robustness.

Tubing, 50 μm i.d., 1/32 inch o.d.,
10 cm PEEKsil

—205-00069

Attaches Trap cartridge to autosampler
trap valve.

Tubing, 50 μm i.d., 1/32 inch o.d., 10 cm
PEEKsil

2205-00069

To attach the autosampler injection valve
to the autosampler trap valve.

Tubing, 50 μm i.d., 1/32 inch o.d., 30 cm
PEEKsil

1205-00040

Waste tubing for autosampler trap valve.Tubing, FEP, 1/32 OK 5-foot roll1200-00320

For PEEKsil tubing connections on all
valves.

1/32 inch PEEK nut with glass-filled PEEK
ferrule (10/ pkg)

15019621

Vials for proteomic analysis11 mm PP 250 µl vial (100/pkg)1910-00104

Slit septum lids for vials11 mm snap cap with slit septum
(100/pkg)

1910-00103
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Table L-1 XIC Table for the PepCalMix Text

CompoundWidthCenter

AETSELHTSLK0.05408.55010

GAYVEVTAK0.05473.26020

IGNEQGVSR0.05485.25302

LVGTPAEER0.05491.26559

LDSTSIPVAK0.05519.79969

AGLIVAEGVTK0.05533.32333

LGLDFDSFR0.05540.27342

GFTAYYIPR0.05549.28633

SGGLLWQLVR0.05569.83398

AVGANPEQLTR0.05583.31360

SAEGLDASASLR0.05593.80053

VFTPLEVDVAK0.05613.34955

VGNEIQYVALR0.05636.35273

YIELAPGVDNSK0.05657.34499

DGTFAVDGPGVIAK0.05677.85827

YDSINNTEVSGIR0.05739.36148

SPYVITGPGVVEYK0.05758.91050

ALENDIGVPSDATVK0.05768.90340

AVYFYAPQIPLYANK0.05883.47380

TVESLFPEEAETPGSAVR0.05964.97741
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Note: For information about processing SWATH
®
 data, refer to the https://training.sciex.com/Course.aspx?c=336

eLearning module.

1. Open the SWATH
®
 Acquisition MicroApp, version 2.0, in the PeakView

®
software and then select Quantitation

> SWATH Processing > Import Ion Library.

2. Change the file type to *.txt and then browse to the library (Human2D_PepCalMix SOP Library.txt).

Tip! The library can be downloaded from http://sciex.com/community/entity/15722.

Note: This is a small library only recommended for processing the SWATH
®
 QC data. Use more in-depth

libraries for processing biological studies.

3. Select the ion library and then browse to and select the SWATH
®
 QC replicate data files that were acquired

with SWATH
®
 acquisition.

4. Click the Retention Time Calibration Protein in the protein list.

The integrated peptides for the PepCalMix peptides that have been spiked in the sample are shown.

Tip! Click through the peptides to confirm that the correct peptides are integrated in all cases.

5. Click the Edit RT-Cal icon ( ) to compute the retention time correction.

6. In the Edit Retention Time Calibration window, click the Calculate RT Fit button to compute the calibration
curve. Refer to Figure M-1.

Note: There is an individual curve computed for each datafile, as shown by the colored lines and points.
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Figure M-1 Edit Retention Time Calibration Window

7. If there are any data points that are falling off the curve or were not detected in the samples, then highlight
the individual peptide XIC row and click Delete to select the peptide.

8. Click Apply if everything looks correct.

9. Set the processing settings as shown in Figure M-2.
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Figure M-2 Processing Settings Dialog

10. Click OK.

11. Click Process to complete the data processing of the replicate SWATH files.

12. After processing is complete, select Quantitation > SWATH Processing > Export > Areas to obtain
the text files of peak areas for use with the SWATH Replicate Analysis Template.
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1. After processing is complete in the SWATH
®
 Acquisition MicroApp, click Quantitation > SWATH

Processing > Export All > Areas to export all of the peak areas to text files.

2. Open the SWATH Replicates Template on a high-performance computer.

Tip! The SWATH Replicates Template 2.0 can be downloaded from
sciex.com/software-downloads-x2110.

Note: The template is a very large processing spreadsheet that requires the 64-bit version of Microsoft Excel
2010 or higher. Instructions for using the template are included on the first worksheet (tab) of the document.

3. Type the metadata on the INPUT-Metadata tab, as shown in Figure N-1.

4. Paste the data from each of the tabs in the exported file in the equivalent input tabs in the template.
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Figure N-1 Metadata

Note: The default settings for the processing controls should be retained.

5. Press F9 to process the spreadsheet.

6. After processing is completed, open the Simple Summary tab and inspect the key results to make sure that
they are of the required quality.

7. If this data will be used to track performance over time, then capture the results from the Results – Single
Column worksheet and paste into a new Excel file for future access.
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Figure O-1 Syringe Line

Action RequiredItem# RequiredPart Number

Connect the syringe to the ion source.Tubing, 50 µm i.d., 1/32 inch o.d.,
75 cm PEEKsil (natural)

1205-00049

Connect the syringe needle to the tubing.Union Microtight, 1/32, PEEK1200-00319

—Syringe, 100 µL11003968
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http://sciex.com/Documents/manuals/nanospray-operator-guide.pdf

http://www.absciex.com/Documents/Downloads/Literature/nanolc-system-integration-test-en.pdf

Human Ion Library: http://sciex.com/community/entity/15722

SWATH
®
 Acquisition eLearning module: https://training.sciex.com/Course.aspx?c=336
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